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Introduction  

E- Sniper is an electronic program for target shooting using a webcam to detect the shots over targets generated by 

the program and store them in a database. 

It is designed to be used with air guns or airsoft small-caliber (4.5-6mm). 

The program allows you to define a set of parameters for classifying shots and make further statistics, by creating 

graphics in different formats. In addition to this user-defined parameters, the obtained score in the shots, the 

distance to the center of the target and the grouping size (calculated by the CTC (Center To Center) method) are all 

stored. 

You can design different models of targets, changing the size, color, line width, etc. There are also regulatory 

measure targets. You can only use the targets provided by the program, as the system needs to know the precise 

measures to be able to locate the shots. 

All targets used are stored in the database along with the data of their shots, and you can view and edit later, 

eliminating shots that we are not interested in and recalculating the target shots group. 

The software license allows the simultaneous use of the program on two different computers. The idea is to use one 

as a central database and the other as portable equipment. 

System Requirements 
The operating system must be Windows 7 or Windows 8. It is not guaranteed that the program Works correctly on 

Windows Vista or other previous Windows versions. 

You must have installed the LocalDB version of SQL Server Express 2012 (this is a free version downloadable from the 

Microsoft website). 

A VGA resolution Webcam (640x480 pixels, 10 fps) is required. 

Internet connection is required to register the license of the program. Once registered, internet connection is no 

longer required, although to free the license to use the program on another computer, the connection will be 

needed again. 

It is recommended, but not essential, to have a speaker system to listen the program indications. In case of absence, 

visual indications are also provided. 

It is also advisable to have at least 4GB of RAM and a dual core processor. In any case, it is necessary to have at least 

1GB of free memory. 
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Quick Start 

Initial data creation 
To use the program, we first need to create a complete set of parameters, to do it, choose the Database option from 

E-Sniper menu. 

 

There are some boxes in each of which you must enter the different characteristics of the shots, which are: 

 Gun model 
 Ammunition type 
 Optics 
 Propellant (for example compressed air, CO2, Green gas …) 
 Shooter name 
 Shooting position 
 Shooting distance: This is a numeric value that is defined without specifying measure units. 

The program uses meters or Yards to calculate the deviation from the target center in MOA (minutes of 
angle). It is advisable to put all distances one of these units. 

 Ambient Light (by example sun, cloudy, electric Light…) 
 Wind Speed: No need to add any data because the program already gives a default value, this does not 

appear in the list, the NA value indicates that wind is not taken into consideration. No matter which 
measurement unit you use, since the program does not process this information in any way. 

 Temperature: Have also a default NA value, there is no need to enter any data. No matter the measure 
units. 

 Shot class: This parameter is intended to classify shots into different groups for example testing, 
training, etc… 

 Trigger pressure: there is an NA default value, so here also no need to enter any data, no matter the 
measure unit. 
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To enter data in different boxes, simply write the value in the text-box above and add it to the list with the middle 

button. 
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Design and printing of targets 
Only use targets printed by the program. We have several models with different parameters. 

To access to this module, go to Targets option from the E-sniper menu. 

It is better to print the targets in draft mode, to save ink and improve the shot detection. 

 

At the top you have the different models. Simply click on one of them to see the sheet drawn on the left side of the 

screen, with its parameters on the right side. Each target model has a different set of parameters. 

There are models with regulatory measures, with one or more targets per sheet, and the parameters can be the 

target radius, the line thickness, the color and size of the center (Bulls-eye) and the  number of targets per sheet. 
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To design the target, simply select the parameters from the right side panel of the module (we not recommend to 

use black color for targets, as the program cannot detect the shots over a black background, unless the target is 

retro-illuminated. It is also recommended not to use too thick lines, as it will difficult the shot detection). 

 

You can also select the printer where you want to print the target; you can provide the number of copies and select 

the page size. It is recommended to use always DIN A4 sized paper. 
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To print the target, just click on the Print option from File menu. 

 

Shooting gallery 
Next, we will select the Shooting Gallery option from E-Sniper menu to start shooting: 

 

The screen is divided in three zones, some control for general parameter adjustment are placed above. On the Left 

side there is a panel where the target image is shown by the webcam, and on the right side the shooting parameters 

selection. 
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Required parameters selection 
To be able to shot, you first have to fill up all the parameters from the Parameters section (no need to select any 

item on Cards section). These values have to be entered previously on the database. You must also print at most one 

target. 
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Frame target  
Once the parameters are selected, you must frame the target, which must be placed in front of the webcam. For the 

program to work properly the target must occupy the largest possible area of the image displayed by the camera. 

 

If you have several cameras, you must select one of them from the dropdown list. 

By pressing the Frame Target button, the image of the target will be shown and you will have to adjust the zoom and 

the position of the webcam so you see the sheet with the targets. 

The framing is to indicate the position of the target by four points. For those sheets with a single target, these four 

points are the centers of the circles shown in the four corners of the sheet, if the sheet contains several targets, we 

will mark the center of the targets located at the corners. 

The order we mark these four points is irrelevant. In case you are not satisfied with any of the marked points you can 

click again near of anyone to change it. It is best to mark the exact center of the frame points, but a small deviation 

will not almost change the results. 
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Once the four points are marked, we use the End Framing button for the program to calculate the center of the 

targets. If we are not satisfied with the result, we can repeat the operation again following the same procedure. 

Although the image of the target does not appear neatly, the program will detect the shooting without any problem 

as long as the lighting is appropriate. 

We can adjust the brightness and saturation parameters of the camera using the controls while you are holding the 

frame. 

The camera can be placed in any position from the target, as long as the distance is enough to cover the entire target 

with the largest size possible. No matter if the sheet is twisted, but it is essential to place the title of the sheet on the 

upper left corner. If we see the image inverted horizontally, we must adjust the parameters of the camera to be on 

the right position, otherwise the program will not work correctly. 
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Shooting 
Before you start shooting, you must indicate the number of shots that you will perform on the target. Is important to 

know that an excessive number of shots may cause the target to break too much and difficult the detection of holes, 

this will depend on the accuracy when shooting. 

 

In sheets with several targets, the number of shoots it refers to each of the targets. 
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To enter in shooting mode click on Shoot button. 
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A countdown will appear that will advise you to move away from the camera, during shooting nothing should be 

placed between the camera and the target. 

 

In case you want to finish before trying all the shots, there is a Finish Target button that keeps all the shooting data, 

and there is a Cancel shooting button to quit without registering any shooting data. 

The Program will indicate you which target and when to shoot it. This is made via audio locutions, although if you do 

not have speakers, you can follow the visual instructions on the screen. In the lower right corner the number of the 

target will appear and on the upper right corner a red box will tell us not to shoot and green when we can. 

The mechanism is as follows, first of all, the name or the number of the current shooter, (there is the option to shoot 

several shooters on the same target, see the corresponding section), next, the number of the target on which must 

to shoot, (only in case of sheets with multiple targets), and finally the order to fire. From this point we can shoot in 

any time, the program will detect the point of impact and indicate the obtained punctuation (if the target model is 

not scored, you will receive an indication that the shot has been detected). To make another shot, wait till program 

indicates you to do so again. 

In case you do not have audio, we should be guided by the red and green box color to know when to shoot. Does not 

matter the time it takes you to aim and to shoot. 
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When you finish shooting, the program will indicates you and webcam will stop recording. If you do not have audio 

you can see the upper right box turns to grey color. 

On the webcam image we can see the situation of the different shots detected on the target, those will appear 

rounded in color circles, with a cross to indicate the center of the hole. 

Next we can select a new target and repeat again the process. 

It is possible to improve the shot detection using the camera adjustment option, as explained in the corresponding 

section.   
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Check Results 
The Shot and Target Query option from the Statistics menu allows you to see the results of shots with score 

data, precision in different units and grouping size of shots. 

 

On the right panel we have a series of filters to select the targets (see the corresponding section). We should select 

the date (the current date is selected by default) and press the Search button. Then all targets used in the selected 

range of dates will appear. 

Placing the mousse pointer over each shoot, the score, the distance to the center in different units, the deviation in 

MOA of the center and the diameter of the grouping of which the shoot belongs, will be shown, 

If we want to see the dimension of the groupings, we have to choose Show CTC on the control panel. 

On the lower right corner, all parameter data of the current target is shown. 
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Database 

E-Sniper keeps your shooting data in a database. There are two kind of data: On one side, the  shooting parameters, 

as  gun model, type of  ammunition or name of Shooter, that must be provided by you; on the other hand, the 

position, precision or score of each shot, and the different targets that you used. This last data it’s kept 

automatically.  

To introduce the parameters that characterize the shots, go to the corresponding program module by selecting the 

Database option from the E-Sniper menu. 

 

Database elements 
We can define the parameters of those next groups:  

 Gun Model: text describing the gun model used to do the shooting. 

 Ammo Type:  text describing the kind of ammunition used. 

 Optics: text describing the type of optic used to do the shooting. 

 Propellant:  text describing the propellant which impulse the pellets. For example, compressed air, Green 
gas, CO2, etc. 

 Shooter: Name of the Shooter. 

 Shooting Position:  text describing the given position to do the shooting (standing, leaning, etc.) 

 Shooting Distance: Value that indicates the distance from the Shooter to target. The program does not allow 
you to indicate the measure units, although meters or yards should be used, because those are the units the 
program uses to calculate MOA. 
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In case you use other measure units, the MOA cannot be correctly calculated. If possible, use only 
meters or yards, but not both. 

 Ambient Light: text describing the type of Light when you shooting (sun, clouds, electric Light, etc.). 

 Wind Speed: number that indicates the wind Speed. You can use the measure units that you want, cause no 
calculation are made with this value. There is a default NA value, which does not appear in the list that may 
be used when we do not care for this parameter. 

 Temperature: number that indicates the temperature at the shooting time. No matter which measure units 
you use. This parameter as a default value. 

 Shot Class: Free text that allows you to define an additional classification criterion, as may be testing or 
training. 

 Trigger Weight: number that indicates the trigger weight. No matter the measure units used. There 
is a NA default value in case you do not care for this parameter. 

  



E-Sniper electronic shooting practice 23 

 

E-Sniper Page 23 of 107 
 

Handling with the parameters 
A control box for each shooting parameter is shown, which consists on a text editor, a list of values and three 
command buttons to modify, store, and delete the data. The boxes are independent one from another, no need to 
finish with one to go to another one. 

Loading New data 
To create new parameter values, you only have to write the value, either number or text, on the edit box at the top, 

and then click the middle button to Save it. The program does not admit duplicate text or value for the parameters, 

if duplication happens an error message will appear. 
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Modifying the existing data 
You can change the name or value of any of the data, as long as the new one does not coincide with the existing 

ones. Select it from the list and press the Modify button on the left. The value will then appear on the text box at the 

top, where you can modify it and then press the Save button to store it on the database. 

 

Cancel the data edition 
Once a parameter is selected to modify, we can cancel the operation by pressing the Escape button on the text box, 

the changes will be discarded and the parameter will remain with it original value. 
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Deleting values 

We can delete the parameter values that we are not interested in by selecting them from the list and pressing the 

Delete button at the right side. The program will not allow us to eliminate any value used by any of the existing shots 

in the database. 

 

Local database 

E-Sniper uses by default a SQL Server express Edition mdf database file, from this point, we refer to it as local 

database. 

Backup of the local database 

It is convenient to do a periodically backup of the local database, to prevent loss of data by system or user error. 

When using the local database, this consists of making a copy of the mdf file; you can do it from the program. In case 

you use a database server you will have to use the server tools to manage it. 
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To copy the local database in another location, we will use the Export Local Database option from the File menu. We 

will be asked to select where to copy the files, and then the copy will be done. 

 

To recover a database from a backup copy we use the Install Portable Database option from the File menu, selecting 

the folder where you have kept the last backup copy. All data introduced after that copy will be lost. 
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Database Server 
Besides local database, there is the possibility to use a SQL Server o MySQL database to store the data. 

Connection Settings 
To configure a database Server, you should indicate the connection data to access it, by using the Database 

Connection from the File menu. 

 

In the dialog box, select the type of connection you want to have active. You will have to configure the access data to 

the server for the connection to work. 
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Connection data consists of the name or IP address of the server, the user name and the password that we will use 

to connect. In the case of SQL Server we can use the option to connect using the Windows user credentials 

whenever we have configured the server in this mode.  

 

The Test Connection button will allow us to validate input before saving, to make sure that the credentials are 

correct. 

You can also configure the version of the LocalDB connection 
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Setting up a Server from the beginning 
Although the program is ready to use the local database by default, we may want to start using a database server 

from the beginning. In this case the first thing you must do is configure the connection to the server as indicated 

above. Next, generate a SQL script that will allow you to create the database on the server. 

If you want to use a MySQL server from another computer, you will have to install a MySQL connector for .NET on 

same computer as E-Sniper program. You can download it from this page 

http://dev.mysql.com/downloads/connector/.  

The version of the connector must be at least 6.1, and prior to 6.7. On the product page several versions are 

available. 

If you have already installed MySQL in your computer, you must check the .NET connector version with the program 

and features option from control panel. 

Database creation script 

To generate the script, use the Generate MySQL / SQL Server Script option (depending on the Server you are using) 

from the File menu, you must select the Initial Database Creation option. 

 

Notepad will open with the corresponding script, which must be run in the database manager tool of the server to 

create the tables and insert the initial values. 

Once the database is created on the server, provided the connection settings and selected the correct connection 

option, all data you generate or introduce will be stored in this server. 

The Management of backups of the database should be made with the tools provided by the Server, because E-

Sniper will only allow you to manage the local database. 

http://dev.mysql.com/downloads/connector/
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Upgrading to a server from an existing local database 
You may choose to use a database server after having stored some data in the local database that interest us to 

preserve. E-Sniper allows migration of existing data to a server infrastructure in a similar way to that discussed in the 

preceding paragraphs. 

Database creation script 

In case of upgrade from the local database to a database server, we also need to configure the connection and 

generate the SQL script for creating the database, but in this case we use the option Upgrade Database Creation. 

The only difference between the two scripts is that in this case does not create default values of the wind speed, 

trigger weight and temperature parameters, that will be imported from the local database. 

 

Import data from the local database 

After creating the database on the server, proceed to import the data from the local database using the Import 

Database option from the File menu. Before you must ensure that the database connection currently selected 

corresponds to the database server. 
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You will be asked to select the origin of the data; you must select Local Database and press the Accept button. The 

data transfer from local to server will start. 

 

Share data between multiple computers 
The E-Sniper license allows you to use simultaneously the program on two different computers. The idea is to use 

one of them as a central database, for example, a desktop computer, and the other as a portable one, which you can 

use for outdoor shooting. 

Share the local database 

If you are using the local database, as this is a file, you just have to copy it to the portable computer, use it to make 

the shots, and re-copy the updated database on the first computer. 

Passing data to a second computer 

To transfer the local database file to a second computer, use the Export Local Database option from the File menu 

to copy it into a directory, for instance, in a pen-drive, to pass it onto the portable computer. 

 

  



32 E-Sniper electronic shooting practice 

 

E-Sniper Page 32 of 107 
 

In the portable computer, use the Install Portable Database option from the File menu to copy the database from 

the directory or device where we copied it previously. 

 

From this point, the portable has the same data that contains the main computer. The database connection of 

portable equipment must also be configured to local database. 

Return data to main computer 

To return the database to the main computer, you must perform the reverse operation, this time from the portable 

computer. First you copy the local database using the Export Local Database option from the File menu of the 

laptop. You can copy the data to a pen-drive, for example. 
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On main computer, use the Install Portable Database option from the File menu to retrieve the updated database 

that you have copied from the portable computer. 

 

Share database with a Server 
In the case you are using a database server, the procedure will be different, since the database is not a file that can 

switch between the two computers. 

Passing data to a second computer 

You will create a database file, similar to the local database, with the difference that in this case will not contain the 

data of the shots, but only the parameters of shooting and the targets that have not been used yet. For this we use 

the Create Portable Database option from the File menu.  

 

You must select the directory where you want to save the database file to transfer to the portable computer, for 

example, in a pen-drive. 
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In the portable computer, get the database created using the Install Portable Database option from the File menu. 

 

Now you can use portable computer to perform the shots on the targets available on this copy. The portable 

computer must have the database connection configured as local database. 

Recover data from Server 

To pass data from the portable computer back to the Server, the portable computer will make a copy of the 

database with the option Export Local Database from the File menu, selecting as the copy destination the directory 

that you will use to exchange data, for example to a pen-drive. 
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On the main computer, import the updated data in the server using the Import Database option from the File menu. 

You must select the directory or device where you exported the data from the portable computer. 

 

This option should not be used in any case to move data between two different servers. If you do this, it is possible 

that some of the values of the parameters get duplicate, generating confusion on checking data. 

Detach database files 
You can detach database files if you experiment problems importing or exporting data 

 

Select the file from the list and press the Unmount button. If this does not work, restart the program.  
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Designing and printing targets 

E-Sniper can only use target models designed with the program, since exact dimensions and configurations data are 

needed. 

There is a design module on the Targets option from the E-Sniper menu. 

 

Selecting the model 
On the top of the module, you can find the different available target models. To select one, just click on it with the 

mouse. 
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Target configuration 
Once a target model is selected, the setting parameters will appear on the right panel. This may vary from a target 

model to another. There are also some parameters to set the printer, the number of copies and the paper size. 

You may use any paper size, but DIN A4 is recommended as on larger sized sheets, the holes could result too small to 

be detected by the system. 

Changing the parameter values, you can view the result on the left side of the module. 

 

Target size 
Although some target models have regulatory dimensions and it size cannot be changed, in general the radium of 

the target is configurable, and you may introduce it value in millimeters with this parameter. On sheets containing 

various targets this value will be applied to all targets. 

 

Line width 
Some of the target models allow you to set the width of the lines. We advise you that too width lines on the printing 

may difficult the detection of shots, also may produce false detections. 
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Central color 
By default, targets do not have defined any color for the center (Bull’s Eye), you can select one changing this 

parameter. You can choose blue, orange or green. Although the program also gives you the chance to use black, it is 

not advisable to use it as the camera cannot detect the impacts on this color. This option is only available for printing 

also the usual targets with the usual black center. 

 

Center size 
With this parameter you indicate from which number start coloring the center of the target. 

 

Number of targets per sheet 
In models with more than one target per sheet, we can set the number of targets in horizontal or vertical, with the 

only limitation that it size does not overlap. 

 

Printing 
Once the target is parameterized, you can print it with the Print option from File menu. You can set the following 

printing parameters on the right panel: 

Printer selection 
With this, you can select the printer from a list. 
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Number of copies 
If you want to print more than one copy, this option will allow you to provide it. Each target have a different number 

of page. 

 

Paper size 
You can select any paper size from the list, although DIN A4 or similar are the most advisable to use. 

 

Paper orientation 
You can print in either horizontal or vertical orientation. 

 

Deleting unused targets 
On the right lower side of the module, is located a list of the available not used targets. You can remove targets from 

the database (for instance if your printed page is broken) selecting the correspondent target and pressing the delete 

button. 
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Available models 

Below a list of available target models that comes with the program: 

Fixed configuration models 
These models have regulatory measures and only the color of the center of the target can be changed. 

10m air carbine 

It is a numbered target of 22,75mm radium with the center starting at number 4. This model is usually used to shot 

with air carbine from 10 meters distance. 

 

The score is calculated using a gauge of 5.5mm. The score value of each shot is that in the innermost circle touched 

by the pellet. 
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Multiple 10m air carbine 

 

Same as above, but allows you to set several targets per page, must have at minimum two horizontal and two 

vertical targets. 
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50 meters carbine 

 

This model has a radius of 77,2mm and center starts at half of number 3. 

This is the model to use with carbine at 50 meters distance. 

Score is calculated using the innermost circle touched by the pellet, which approximate caliber, you would have set 

on the Shooting Gallery module. 

  



E-Sniper electronic shooting practice 43 

 

E-Sniper Page 43 of 107 
 

10 meters air pistol  

 

This model has a radius of 77,75mm and center starts at number 7. It is marked for inner ten, although the program 

does not distinguish between a ten and a inner ten. 

It is used with air pistol at 10 meters of distance. 

To calculate the score an 11,5mm gauge is used. The value will be the inner circle that had touched the projectile. 

In case we do not want to use the gauge to determine the score, there is a configurable version that can be used 

instead. 
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100 meters bench rest 

 

It has a 31,75mm and does not have score. It is used for precision shooting. 

Multiple bench rest 

 

Multiple target version of the previous. 
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Models with variable settings 
The following targets are variable in size and some of them are based on the regulatory targets. 

Numbered and framed Target 

 

This target does not allow you to change the center color; it is framed with a 2cm width circle border. 

The score it is calculated getting the innermost circle touched by the pellet. 

There is also a version with inner ten 
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Target numbered with ten point 

 

In addition of the radius, we can also set the center color and the number where it starts. 

The score is calculated getting the innermost circle touched by the projectile. 
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Multiple numbered targets  

 

This is the multiple target version from previous. 

There is also a version with inner ten. 
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Numbered target with inner ten 

 

This other numbered target model, allows you to change the color of the center and the number where it starts. It 

has a circle for a ten and inner then, although the program does not distinguish between ten and the inner ten. 

Score is calculated getting the innermost circle touched by the projectile. 
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Unnumbered target 

 

Unnumbered target for precision shooting, the shots are not scored, only data of precision and grouping are 

collected. 
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Multiple unnumbered targets 

 

This is the same as above but offers you multiple targets per page. 
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Unnumbered framed multiple targets 

 

This target model without score it is for precision shooting, all lines and frame are configurable. 
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Shooting Gallery 

With this module you can do the shooting practice. To access it, use the Shooting Gallery option from the E-Sniper 

menu. 
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Camera placement and settings 

Camera placement 
It is highly recommended to have a small photo tripod in order to place the camera as steady as possible. If the 

webcam does not have a thread to fix it in a tripod, we can build an adapter with a nut glued on a metal sheet, like in 

the image below: 

 

Webcams are designed to operate over short distances; therefore it should be placed close to the target. The 

detection system will work best the less perspective in the target image. A good place to put the camera is about 

50cm in front of the target, and 20cm below. If necessary, you can place a protection behind the camera to prevent 

accidental impact on it. You can also use the zoom, if available, to position the camera farther away from the target 

and reduce the perspective. 
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Adjust camera settings 
To adjust the camera settings (mainly brightness and contrast) first you must open the Targets module and print the 

adjustment card: 

 

Next, open the Shooting Gallery module. Select the parameter Current Target, expand the dropdown list and select 

Camera Adjustment. 

 

 

Next, you must select the webcam you want to use in the dropdown located above the camera image. If you only 

have a camera installed, it is selected by default. 
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Then, frame the card, pointing the camera on it and pressing the Frame button located over the image: 

 

 

Framing the adjustment card 

Mark with the mouse (you can correct the position by pressing near again) the four frame points in the drawing 

corners and press the End Framing button, next to the Frame button: 
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All the red crosses must be located so that its center is inside the black marks. If not, you can repeat the framing: 

 

When you are satisfied with the frame, press the Camera Adjustment button and you can see how many black 

marks are detected as shots. The closer you are of 100%, the better the system will work: 
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Use the camera adjustment controls to vary the contrast and brightness to raise as much as possible the hit 

percentage: 

 

It’s better to adjust the contrast than the brightness, if you light too the image, the holes are also lighten, and will be 

harder to detect. 

 

You can also change the ambient lighting on the target to try to obtain the best possible performance. This card also 

allows you to check on what target color are best detected the shots. However, although you get the 100%, the 

program may fail sometimes to detect some shots. But, with 100%, the camera setup is optimal. 

To end the camera adjustment, save the settings and close the camera controls dialog, and then press again the 

Camera Adjustment button. 

We suggest that you repeat this operation at the beginning of every shooting session, because the light conditions 

may have changed and the old settings are no longer valid. 
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Perspective 
The perspective can influence in the program's ability to correctly determine the position of the shots, this is 

especially important in the sheets with multiple targets (only in the full version). 

 The best camera position is in front and below the target. The following image shows a correct perspective: 

 

The camera is located about 50cm away from the target and 20cm below. 

In the next picture we have a higher perspective, but also valid: 

 

The camera is located about 40cm below the target. 
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In this picture we see a perspective that can be problematic: 

 

With a perspective like this, is likely that the sheets with a single target did not get too many problems, but the 

sheets with several targets (only in the full version) can potentially fail in shot detection in the targets located to the 

left of the sheet. This would also apply the right targets if the perspective was the reverse.  
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Selecting the shooting parameters 
First of all, you must select the target which you want use and the shooting parameters. To do so you will use the list 

on the right side panel of the module. 

Selection of the target 
On the parameter list you must select the target you want from the list on Actual Target. 

 

Selecting the parameters 
One by one you must select each parameter from the list. It is required to give a value to each of them. You can 

create groups of parameters by default using the Shooting Cards (see later), so you can do it quicker. 

 

Use parameter cards 
If you often use a determinate parameter setting, you can pre-define it on a Shooting Card. (see later the 

explanation on how to create it). By selecting a Shooting Card you assign at once all the parameters that are defined 

on it. 
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You have to fill in the rest of parameters one by one. 

 

Multiple shooters over the same target 
There is the possibility of more than one Shooter over the same target. To use this option, you should create a card 

with the list of shooters and optionally the shooting parameters of each one. 

The program will indicate you when each shooter turn is, and will change automatically the parameters.  

Creation of these cards is explained in the Shooting Cards section. 
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Shooting configuration 

Number of shots by target 
It is essential to indicate the number of shots that will perform on the target. In case you are using the option of 

multiple shooters, this value is used to each Shooter, doing each the same number of shots. On sheets with some 

printed targets, this indicates the number of shots to be done on each target. 

The program can distinguish two shots close together, but only up to a point, so, if your accuracy is high, you must 

select a smaller number of shots. Every time you finish shooting on a target, this value is reset to zero and you must 

re-enter it. 

  

Cycle mode 
If we use a several targets page, the default mode consists on shooting all shots over the first target, then over the 

second, and so on, if you activate the cycle mode, you will do just one shot over each target and start again at the 

first one till you finish all shots. 

 

Caliber adjustment 
With this control, you can modify the reference size from the holes of the bullets on the target. The picture 

represents the approximate diameter of the shot holes in the target, as viewed in the webcam image. The default 

value is valid for all calibers of air guns, but you can change it in case that the holes are larger or smaller than the 

mean and are not properly detected by the program. 

  

At the bottom you will have to enter the real size in millimeters of the holes that will produce shots on target. This 

value is useful for controlling the assignment of scores. It cannot be calculated from the actual caliber of the 

projectile as, for example, is different the orifice size that produces a pellet-shaped ball of that of a match type 

pellet, even of the same nominal size. 
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Fail distance 
Here you can optionally specify the distance in millimeters from the center of the target from which a shot is 

considered as failure and it is not scored. If the value is zero all shots count. These shots are not stored in the 

database nor be discounted from the selected number of shots per target. 

 

On scored targets, any shot out of the target will be considered as fail, although it will be stored in the database, 

unless it is out of the indicated fail distance. 

Random shooting 
When you select a target with multiple bull eyes, you can select the random mode, in which the targets are selected 

randomly. In this mode, you must define a number of seconds to limit the time to fire each shot, after this time, the 

shot will be considered failed. 

 

Grouping adjustment 
Once you finish shooting over a target, the program does calculate the grouping of shots and the distance between 

centers of the most distant shots. With this control you can exclude the shots that are too far from grouping center. 

As low is the value you select, more shots can be discarded, but only groups of three shots or more will be 

calculated. 

Only one group per person and target is calculated, in which all shots are registered unless the discarded ones. 

 

Sensitivity adjustment 
You can improve the shot detection using the sensitivity adjustment control, although this may produce false 

positives 
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Target Frame 
Before you start shooting, you have to indicate four reference points for the program to place the target and 

calculate its size. On pages containing more than one target, you will have to mark the center of the four targets in 

the corners, if there is only one target, you will mark the exterior four points. 

You first have to select the webcam that you are going to use from these on the drop down list. If you only have one 

camera installed, it will appear selected by default. 

The webcam should be placed somewhere you can see the target completely. The closer the perpendicular is from 

the center, the better the frame will be. 

If the image of the target is too small, the holes will also be too small and the program may have problems to detect 

them.  It is better if the target fits all the image, you may use the camera zoom to get it right, 1 meter distance from 

the target should be enough distance to place the webcam.  

It is also important that on the webcam image the title of the page is placed on the upper left side corner.  Webcam 

may be set up to invert the image in horizontal by its own control panel. If you do not so, the shot position will not 

be correct. 
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It does not matter if the image of the target is not very clear or it’s a little askew, as long as there is enough light and 

the title it is well placed, as indicated before. 

With the Frame Target button the cam will go on and you will be able to adjust its position till you see the target 

correctly. Once done that, you will check the four points by clicking in with the mouse. 

 

No matter the order we check the points, you do not have to check exactly the center of this points but as more 

precise you are the better the frame will be. 

If you check a point too far, you can correct its position by pressing again near to the correct place. You can also 

cancel the frame operation and restart it again. When you finish with the frame, press the End Framing button on 

the right side of the frame target button. 
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Once you have pressed End Framing button, if you have checked the indicated points, center of the target will be 

shown to you to test that is done properly. If you want to change it you can start as many times as you want. 

 

Once frame is finish, the Shoot button will activate. 

This process must to be done with each new target, no matter if it is equal or different at the previous one. 
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Shoot over Target 
When pressing the Shoot button, webcam will go on and a countdown will appear to give us enough time to get 

away from the target. When it reaches to zero nothing should be placed between the webcam and the target, or it 

may obstruct the proper shot detection. 

 

Next to the fire button, there are another two to stop the round. With the Finish Target buttonthe round ends and 

the target will be closed with the shots fired to this moment (if there are not shots, they not will close) 

 

With the Pause Shooting button, you can stop the round and modify the shooting parameters. When you start 

again, the target will continue from the point where the round is stopped. 
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The program will mark the shots with a color circle with an inside cross. In one player round this color will be the 

selected on the shooting parameters. In case of multiple shooters, each shot will be marked with the color assigned 

in the shooters card (see the Shooting Cards section). 

Shots should be done one at a time.  

 

Although the shot holes may have different sizes, the program will store them with the reference caliber indicated 

on the correspondent control. This caliber will be the used for the program to calculate the score. Precision does not 

depend on caliber, as only the shot center is taken on consideration. 

We may change the caliber to get bigger or smaller holes, however this may affect the shot detection. 

Audio indications 
If we have a speakers system, the program will give us indications by audio locutions. It will also indicates if the shot 

is valid and the score. 

First it will indicate the next shooter by the word shooter followed by the shooter number or the name, if we have 

previously recorded it (see the Utilities section). 
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Next it will indicate the target over you have to shot (only in case of pages with some targets), saying the word 

target followed by the number. 

Finally, they will indicate when to shoot by the word fire. From this moment we can shoot when we want, no matter 

if we take long to aim and shoot. 

If shot is detected correctly, you will receive one the next messages: 

 Ok: in case of a non scored target. 

 Fail: in case the shot is outside the target but has been detected. 

 The number with the obtained score, from one to ten. 
 

If we do not receive any indication in some seconds, it will mean that the program has not detected any hole and 

you can shoot again. 

Once detected, do not shoot again until the fire indication is given. 

When all shots are done, the program will indicate with the Word finished. 

Visual indications 
In case you do not have speakers, the program offers you visual indications; however you will have to be able to 

view the computer screen. 

On the upper right side of the screen there is a rectangle which color will change to indicate when you can shoot. 

With red color, you should not shoot; when it turns green you can shoot again. When target is finished, the rectangle 

turns grey. 

On the lower right side there is a rectangle where it will show the number of the target, next to it there is another 

rectangle with the color assigned to the current shooter. 

There is no visual indications to tell the obtained score, although you can check if the shot has been detected,  in 

that case it will appear circled in color, if shot was fail it will appear marked with a cross. 

In case that the shot has not been detected, the program is not able to gives us any indication and the upper 

rectangle will remains in green color. 

  



70 E-Sniper electronic shooting practice 

 

E-Sniper Page 70 of 107 
 

Shooting cards 

There are two types of shooting cards; one is to select a group of parameters by default and the other to set a list of 

shooters to be used with the multiple shooter option. 

You can access to this module through the Cards option from E-Sniper menu. 
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Default parameters card 
To create a new parameters card, we will use the upper half window. On the right there is a list of the existing cards 

and on the left the parameters of the current selected card. 

 

To create a new card, write their name on the text box on the upper side of the editor; then proceed to select the 

default values for the parameters, leaving blank those you want to manually provide. 

There is a button to clear all values above the list of parameters. 

To store the card on the database, you will use the Save button placed below the text box, in the center. 

To modify an existing card, you must select it from the list and then press the Modify button, on the left side of the 

editor. After the changes are made, you must press the Save button to store the card on the database. 

If you want to cancel the edition of the card, you can set the focus on the text editor and then press the Escape key. 

All changes will be lost. 

At last, you can remove one or more cards from the database by selecting them in the list and then pressing the 

Delete button at the right of the editor. Deleted cards will not be recovered. 
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Multiple shooters card 
The editor of shooter list cards is placed on the lower half of the module. The management of cards works the same 

way than default parameters cards. 

 

To add a new shooter to the list, first select the name of the shooter from the drop-down list, placed on the left side 

of the editor. You must also select a different color to each shooter. 

You can optionally assign a default parameters card for each shooter, in order to automatically select shooting 

parameters like gun model on his turn of shoot. During the round you will not be able to change any parameter. 

The data for target shooting and cycle mode will be applied to all shooters of a card. 

If you want to remove a shooter from the list, you must select them and then press the Delete key. Don’t forget to 

save the changes after deleting. 
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Shooting statistics 

E-Sniper allows visualizing statistical graphics constructed with the shooting data stored in the database and create 

documents that can be printed and saved in files. These graphs are made with the grouping, accuracy and score of 

the shots stored in the database. 

Search for targets 
You can access to this module by selecting the Shot and Target Query option from Statistics menu. Here you can 

visualize each one of the stored targets on the database and obtain information from each shot, like score, accuracy 

and grouping size. 

 

At the top on the right side of the module there are some controls to search for targets, calculate groups and delete 

targets and individual shots. 

Below there are some filters that can be used to select the targets and shots that you want to visualize, obtaining 

only the ones that meet the chosen criteria. 

Below the filters there is a list with the parameters of the selected target in addition to the mean accuracy, total 

scoring and group size. 
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Selecting the date 
The date filter consists on a drop down calendar on which you can define the time period to get data from the 

database. Current date is selected by default. 

 

This calendar let us select different date periods (days, months, quarters, fourth months, semesters or years ), using 

the track bar control on the right side. Each time you change the type of period the last selection are lost. 

 

To select dates click on with the mouse left button. You can unselect by clicking again. 

You can also select a range of dates pressing with the left mouse button over the initial date and then with the right 

button on the final one. 
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Simple Filter 
Below the calendar you have the simple filter selection. Select a value for one or more parameters, only the shots 

with the selected characteristics will be shown. Targets with shots that not accomplish the criteria will not be shown. 

 

Use of composite filters 
In some cases, there is the need to apply a more sophisticated filter; you may want to select more than one gun 

model; select shots fired between a determinate range of temperature, etc… 

 

For the creation of this filters, see the Composite filter section further on. 
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Data search and display 
Once the filters are selected, you must press the Search button to obtain the targets that match the criteria and they 

will be shown on the left side of the module. If there are multiple shooters in a target, each shot are colored with the 

color corresponding to the shooter.  

 

You can go to the next or the previous target with the buttons placed on both sides of the Search button. 
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Score and accuracy 

If you move the mouse over one shot, the correspondent data will appear as follows: 

1. Shot Score 
2. Distance in mm to the center of the target. 
3. Distance in inches to the center of the target. 
4. MOA (minutes of angle of deviation from the center). 
5. CTC: Diameter of the group to which the shot belongs. 

 

Distance to calculate the MOA 
In order to calculate the deviation in MOA, you must select a unit for the distance, may be in meters or yards. Of 

course, the shooting distances provided in the database, must be in one of these units. 

With this data we can calculate how much the deviation will be on a determinate distance. It is used mostly to adjust 

telescopic sights. 
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Grouping calculation 

The shot groups will be automatically calculated at the end of each round of shooting, although in this module we 

can recalculate it in the case that you eliminate some shots (this will have to be done manually, the CTC does not 

automatically recalculate when shots are deleted). 

To view the circle that indicates the size of shot grouping check the Show CTC control. 

 

This circle may not content all the shots, it diameter is equal to the diameter of the grouping, and it is placed on a 

way that the two shots used on the calculation (the most distant ones) are located in opposite sides of the circle. It is 

possible that some of the shots are left out of the circle. 

If we want to re-calculate this value we should press the Recalculate CTC button. You can check the Adjust CTC 

control if you want try exclude shoots very far from the rest, you will indicate a value between 1 and 4, knowing that 

as low the value the more probabilities for the most distant shots of being excluded. 

In any case, less than three shots will not be considered as a group. 

Deleting shots 

It is possible that you want to remove some shots from the database. To do this you must press the Delete Shots 

button to enter in deletion mode. The mouse cursor changes to a cross when passing over the target. 

Pressing over the center of the shot that you want to remove, they will be eliminated.  

To exit from deletion mode, press again the Delete Shots button. 
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Delete a whole target 
It is also possible to delete a whole target along with all their shots by pressing the Delete Target button. The current 

target will be removed from database. 

Graphics 
With this module you can create documents with different type of graphs and tables with scoring, precision and 

grouping data. 

To open the module, use the Graphics option from Statistics menu. 
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Tools panel 
The tools panel it is placed on the right side of the module, although we can move it to the left side pressing the 

arrow located on its edge. 

You can hide and show it by pressing the diamond above the arrow. 

 

It is divided in three different zones of tools used to create and parameterize the graphics and charts. 
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Types of graphics 

At the top there is a list with the available graphics types. You simply have to select one of them and drag and drop it 

over the page surface. 

 

Data filters 

Once the graphic is created, you can define its content dragging and dropping onto one or more of the filters from 

the list on the central panel. 

There are three types of filters: individual elements (for instance a determined gun model). 

 

Composite filters, which are filters made up of several parameters and value ranges, as explained on the Composite 

filters section. 
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Complete groups of elements; to add at once all elements of a particular parameter type. 

 

Calendar 

On the bottom of the panel, there is a calendar to select the dates covered by the graph. 

With the track bar placed on the right you can change the period of time to work on. 

 

Months: 
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Quarters, fourth month and semesters: 

 

Or whole years: 

 

To select a determinate period of time you must press on with the left button of the mouse, by pressing again you 

deselect it. You can select some periods of time this way, or a full range pressing the left button on the first period 

and the right mouse button on the last. 

Each time you change the type of period, the last selection is lost. If you change the page on the calendar, the 

selection done in other pages will remain unchanged. To clear the entire selection in a page, click on an empty box.  

Managing document pages 
The rest of the module contains the pages of the current document. 

Adding and deleting pages 

You can add a new page at the end of the document, or delete the current page with all its content. 
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Move to another page 

You will use this buttons to move from the current to the previous or to the next page. 

 

Change the scale of the page 

You can increase or decrease the scale of the page, to work easily with the graphics. This will not affect the printed 

copy. 

 

Change the order of pages 

You can move the current page backwards or forward with this buttons. 

 

Change orientation of pages 

To change the orientation of the current page from vertical to horizontal you will press this button. Graphics on the 

page must be repositioned manually. 

 

Lock / unlock page 

By locking the current page, you cannot modify the graphics on it, and his data will not be updated after loading it 

from disk if the database has changed. You can unlock it the same way. 

 

Setting the default calendar 

You can select a calendar by default for the current page. This default calendar will apply to all the new graphics on 

the page. The calendar of the existing graphics is not changed. 

If you change the calendar of a graph, the default calendar of the page does not change. Page and graph calendar 

are independent. 

If you do not define a default calendar, the graphics will be created with an empty calendar comprising all the dates 

in the database. 
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Creating charts and tables 
To create a new chart you must drag it from the tools panel and drop on the page on the desired position. 

Size and position of the graphics 

You can move the chart to a new position by placing the cursor over it until it takes the form of four arrows that 

starts from the center, pressing the left button of the mouse and dragging it to a new position. 

Size of graphics can be modified placing the cursor over any of the small squares placed on the edges. This will 

change shape and show a couple of opposite arrows that indicates the direction in which the size will change. 

Pressing the left button of the mouse and moving it will change the size of graphics. 
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Add and remove filters 

After creating the chart you can drag on either of the filters from the tools panel. While all of them belong to the 

same category, they will accumulate.  When adding a filter from another category, the actual filters are cleared. 

Graphics have an additional filter to select the type of target to show on graphics; that can be any of the models on 

the database or all the models at once. This is interesting basically for scoring as scores obtained on different sized 

models are not equivalent. 

 

If you drag a filter for a generic type of element (for instance, gun model) all the elements of this type contained in 

the database will be added to the graph at once. This may be very helpful if you want to add a large number of 

elements of a determinate type. 

A filter can be removed by placing over the mouse and pressing the left button. The program will indicates this 

option showing the text Remove filter. For instance you may want to remove a gun model for which there is no data. 

Graphics must be selected first to be able to remove the filters. 

If you double click over the graphics with the left button of the mouse, the data shown will be updated without need 

to modify the filters. 
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Changing colors 

 

Next to the filters there is a box that allows you to change the color of the graph for the selected filter. To do it you 

must press onto the rectangle with the left button of the mouse and a palette of colors will appear for you to select. 

Graphic must be selected to change the color. 

Cut, copy and paste 

You have the usual options for cut, copy, paste or delete the selected graphic . You can use the Edit menu or the 

standard shortcut keys. 
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Score histogram 

With this kind of graphic you create a histogram with the score distribution. Each one of the bars is proportional to 

the number of shots that obtained the score, from one to ten. There is also a column for the fails (F column). 

 

The high of each bar is the number of shots obtained or they percent over total. On the title of the graphic you will 

view the total number of shots and the corresponding number at each filter. You can view also the range of dates in 

the calendar of the graphic. You can change the scale between number of shots and percentage over the total 

pressing over the scale with the left button of the mouse. 
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Percentage pie 

This kind of graphic shows the proportion of shots for each one of the elements from a determined type of 

parameter. 

 

On the title of the graphic it is indicated the total number of shots and the dates range selected on his calendar. This 

kind of graphics only accepts the type of filter for complete group of elements, as the percentage are calculated over 

the total of elements of a determined type. 

You have a version of this graph for shots in scored targets only and another for the total of targets, the precision pie 

(accuracy is always calculated for every shot on all types of target, score not). 

On the image you can view the proportion of shots fired by each on targets with score, being 2009 the total number 

of shots. 
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Linear graphics of evolution 

With this type of graphics we can view the evolution in time of mean score, accuracy or grouping size in the dates 

selected on the calendar. In the title bar you can view the total shots corresponding to each one of the filters. And 

the range of dates selected. 

 

On the vertical axis it is shown the mean value of score in points, accuracy or group size in millimeters or inches, 

being able to change between the two measure units pressing over the scale with the left mouse button. The graphic 

must be selected. 

 

On the horizontal axis there are the dates of the selected time period. If graphic is not wide enough to show all the 

time periods in the selected format, the scale of time will be adjusted automatically to a bigger type of time period 

(for example changing from days to months, quarters, etc…). 
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Tables 

You can create tables for total and average score, maximum or mean precision and group size, with additional filters 

from the type of target and shot class. You can change these filters by pressing on the corresponding box with the 

left mouse button and selecting a type of target or a shot class on the dialog box. The table must be selected. 

 

Once the graphic is created, you must drag the filters form the files. You can do it one by one or using the complete 

group filters to create all rows at once. 

 

If you click with the left mouse button on the text of a row, it will be removed from table. You can also change the 

type of measure displayed (total, mean or maximum) by pressing on the header with the left mouse button. 
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Once the rows are created you will add the columns by dragging another type of filter (cannot be the same that for 

the rows) over the column of totals. 

As the chart has not enough space to put the names of the filters in the titles of the columns, they will be colored in 

the same color as assigned to each filter. 

 

If chart is not wide enough, the value of the data will not be shown until the size is modified. 

The rows of the table are automatically organized from higher to lower values depending of the type of measure 

that is shown. For example, if you are viewing scores, the first row corresponds to the higher score. 

When showing average values, you will see that the total is changing as you add more columns, and may not 

correspond with the total obtained without any column. This is due to the distribution changes if you consider the 

total of shots or different totals grouped by different parameter values, like gun models. The totals column always 

shows the average value of all the columns. 

Text box 

This kind of graphic does not show any shooting data, but can be used to put free text on the document pages. 

 

Text may content some lines and tabulations. You can change the font family and size. 
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If you double click on the text box you can edit its content with the following text box: 

 

With the button located on the top right corner, you can change the family and size of the font. Not all the types of 

fonts are valid. In case you select a non-valid one an error message will appear. 

 

Image 

You can insert images on your graphic documents dragging a Image component and double-clicking on it to select 

the image file. 
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Save and open graphics files 
Graphics are not stored on the database, but in files with .ges extension. To save the files use the Save or Save As 

options from the File menu. 

 

You can open one document with the Open option from the File menu. 
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The documents containing graphics will be updated each time it is open with the new data that could already exist 

on the database. If you do not want this to happen you must lock the pages as explained earlier. 

You will not be able to open graphic files created with data from another database that the selected one, as it 

obtains the data from the current database, not from the file. 

Save as image 

You can also save the current page or any of the individual graphics as an image file in bmp, jpg or png format, using 

the Save as Image option from the File menu. 

 

In case there is no graph selected, the whole page will be saved as image. In other case it will only be saved the 

selected graphic. 
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Printing Graphics 
You can print all document pages, using the Print option from the File menu. 
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Composite filters 
Filtering only with individual parameter values may not be sufficient to select the data as needed. 

You can create filters composed of various parameter values using the Filters option from the Statistics menu. 

 

The filters module is divided in two parts. On the upper side you have the editor, which left side contains a list of 

parameter values to apply to select the shots and other two lists to define ranges of numerical values, for example 

temperatures between 10 and 25 degrees. 

On the right side of the editor it is a list of all filters stored in the database and here you can create new filters or 

modify and delete the existing ones. 
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Filters components 
On the lower part of the module there is a list for each one of the shooting parameters. 

 

Fixed values 

On the list of matching elements you can put those values that should match the shots that you want to select with 

the current filter. To add values to this list, drag and drop them from one of the lists of parameter values. 

 

If you add some values of the same type of parameter, as for example some gun models, the shots matching any of 

this values will be selected. If you add some type of parameters, the shots matching any combination of values will 

be selected. 
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Value ranges 

You can define value ranges for the numeric parameters, like temperature, distance, wind speed, or trigger weight. 

One of the lists contains the lower value and the other the upper value of the range. You can define more than one 

range for a parameter or add some ranges of different parameter types 

 

To put a value into these lists, just drag and drop it from the corresponding parameter value list. If you only 

introduce values in one of the lists, the values selected are all the higher or lower than this. For example if you move 

a temperature value of 18 to the Larger than list, all shots fired at 18 degrees or more will be selected. 

Deleting values 

To delete the values of the lists, just select them and press the Delete key. 
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Add new filters 
To create a new filter, you should write its name on the text box, on the upper side of the editor and drag the values 

of the parameters onto the corresponding list. 

 

Once filter is defined, click the Save button to store it in the database. 
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Modify the existing filters 
To modify an existing filter, you must select it in the editor list and click the Modify button. 

 

Once you have finished with the changes you should store it back on the database clicking the Save button. 

Cancel changes 

To cancel the changes without saving, press the Escape key being the focus on the text editor. 
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Delete filters 
Finally, you can delete one or more filters by selecting them in the list and pressing the Delete button. 

 

Utilities 

Installing new sounds 
You can replace the default locutions that come with the program using the Install Sound option from the File menu. 
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Program locutions 
To change the program locutions, you should first record a 16bit wav file with the word and the name of the wav file 

to replace. The names of the wav files for the standard locutions are the following: 

 Numbers: the name of the file is the corresponding number: 1.wav, 2.wav, etc. 

 Target.wav: the Word “Target”. 

 Fail.wav: The Word “Fail”. 

 OK.wav: The Word “OK”. 

 Shooter.wav: The Word “Shooter”. 

 Finished.wav: The Word “Finished”. 

Name of shooters 
The program indicates the current shooter with numbers. You can record wav files with the names of the shooters 

and installing it in the program. The name of the file must be the shooter name exactly as it appears on the 

database. 

Selecting the language 
E-Sniper can use either Spanish or English as user interface language. You can change between the two with the 

corresponding option of the Language menu. 

 

The program will restart with the chosen language, and will keep working in that language until you change it again. 
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Licenses 
To use the program, you must first obtain a license key and register them with the program. A license allows you to 

use the program only in the computer where is registered, with the Windows user that registered it. Each license key 

allows you to register it in two different computers. 

Register license 
First time you run the program, you will be asked to introduce the key to register the license. You must have an open 

internet connection to register the key. 

Once the product is registered there is no need for the connection. 

Release license 
You can use the program in any computer, but you can only have registered two computers or two users at the same 

time. To use it in a third computer, you must first release the license in any of the registered computers (it will not 

be working on this computer or user until you register it back). 

To release the license key an open internet connection is required. Use the Release License option from the File 

menu to do it. 
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Program updates 
E-Sniper provides one option to install program updates; these updates can add new features or fix bugs. Updates 

are free and can be downloaded from the page 

http://www.e-sniper-shooting-practice.com/en/downloads/download-updates. 

Once downloaded the file, just unzip it into a folder on the local disc (excepting the program directory) and use the 

option Update E-Sniper from menu Add Ons. 

 

Once installed the update, you can delete the unzipped and the downloaded files. 

E-Sniper Add-Ons 
In the product website a development kit is available to extend the program with new features implemented by 

third parties. There are also sample add-ons that can be downloaded and installed. 

These add-ons consist of class libraries that can add new camera drivers or new forms. To download the add-ons 

developed by the author of the program, you can access the page http://www.e-sniper-shooting-

practice.com/en/downloads/download-updates. 

Once downloaded the file, unzip it to a folder on local disk and select the Install Add On option form the Add-Ons 

menu. 

 

Once installed the add-on, you can delete the unzipped and the downloaded files. 
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If the module contains new forms, these will appear as new options in the Add-Ons menu 

 

The new camera controllers will be displayed in the drop down list of cameras in the shooting gallery module. 

You can enable and disable these extensions using the option Manage Add-Ons, in the Add-Ons menu. 

 

Activate or deactivate the modules by checking or unchecking the corresponding check box 

 

The program will restart to apply the changes. Inactive modules do not appear in the menus until be re-activated. 


